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Introduction

Conventions Used in this Document

This document uses the following conventions:

The names of screens, windows, fields, and other features displayed by the software are shown
in bold type.

Information you enter into the software is in bold type, as in the following example: Enter
Miscellaneous in the Amount Type box.

Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK]

[ ]
[ ]
[ ]
[ ]
and [Post].
E Helpful information to make your experience better.

E NOTE: This symbol draws your attention to information of particular interest, such as information
not included in steps.

? CAUTION: This symbol draws your attention to information that is important because it can help
you avoid a costly or time-consuming error.

%]

IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Introduction

MyAssistant Upgrade Guide

This document steps you through upgrading to and configuring Sage 300 CRE MyAssistant 20.3 If you are
installing the MyAssistant software for the first time, please refer to the MyAssistant Installation Guide
included in the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps:

1. Upgrade the MyAssistant Server software.

2. Upgrade the MyAssistant database and confirm previous settings by completing the MyAssistant
Configuration Wizard.

3. (Optional) Upgrade the MyAssistant Drive Mapper.

4. Upgrade MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant is
used.

Upgrading the MyAssistant server should take approximately 30 minutes. Upgrading each MyAssistant
workstation should take approximately 10 minutes.

E CAUTION: MyAssistant 4.0 and higher can upgrade directly to MyAssistant 20.3. If you are
running MyAssistant 3.x or earlier, upgrade to MyAssistant 4.2 before upgrading to MyAssistant 20.3. If
you upgrade from an unsupported path you risk corrupting your MyAssistant data.

Before You Begin

o Determine the computer where the MyAssistant server software is currently installed. It is most likely
on your Sage 300 CRE server.

e Log in to the server using the Windows username that was most likely used to install and activate the
MyAssistant server. Most often this is a Windows Administrator account.
Create a backup of your MyAssistant database prior to upgrading the software.
Ensure the latest Microsoft Windows and Microsoft Office updates have been installed. Installing the
High Priority updates is recommended.

¢ Confirm all machines where MyAssistant will be installed are running Sage 300 CRE 20.3, including
the MyAssistant Server.

Restart the MyAssistant server prior to performing the upgrade. This will complete any Windows
or other software updates where a restart is required.

Support and Training

Telephone Support

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone
support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following
exceptions:

e Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)

e Standard United States holidays

e Quarterly company meetings

Upgrade Guide Page 6



Introduction

Sage Customer Portal

You may log on to the Sage Customer Portal at:
https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:
¢ Knowledgebase: Find answers to your questions, access downloads, and subscribe to your
favorite articles. This service is available online 24/7.
e Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat
hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as
telephone support.

® Online Support Request: If you have a question or an issue that is not urgent, you can submit an
online support ticket. A customer support analyst will contact you during regular telephone
support hours.

Education & Training

Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available
and upcoming classes.

How to access MyAssistant training options in Sage University:
1. Enter www.SageU.com in your web address bar.
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Inthe page that opens, click [Product Training] on the left side of the screen.
Click [MyAssistant] in the list that opened.
Select either [Realtime Learning] or [Replay Leaning] and review the available options in each.

oA

How to access Complimentary MyAssistant Training in Sage University:
1. Enter www.SageU.com in your web address bar.
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the
MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.
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Back Up the Database

Chapter 1 — Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant
database.

1. Log in to the MyAssistant server using the Windows account used to install and activate the
MyAssistant Server. This is often an Administrator account.

by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant Configuration

@] 2. Open the MyAssistant Configuration Manager using the icon on your desktop (pictured left), or

Manager
3. Click the tab labeled MyAssistant Database Connection

4. Click [Backup Database...] (highlighted below)

@ MyAssistant Server Configuration Manager = [} *

b - The folowing is used to connect to the SQL Server instance that contains MyAssistant database 7]
roduct Activation

| SQL Server Database Connection |

SQL Server Mame: @ | DESKTOP-BI10VPD
Sage 300 CRE Data Folders

SQL Server Instance: 15D
Motification Email Accounts Q o

Port Number: O 45812

Server Opfions
Backup Database. .. Test Settings...

\ oK Cancel
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Back Up the Database

5. In the new window that opens, select the location where the backup of the database will be
stored. A default location will be prefilled, but can be changed by typing into the text box or using
the [...] button to the right of the text box.

2] Backup Database

| Backup Location

Create MyAssistant Database Backup.

Select the location to store the generated backup and dick the button [Badkup MyAssistant Database] to complete your backup.

Backup Location: C:'\Users\Administrator \Documents MyAssistantBadwp_04_28_2021.bak

Backup MyAssistant Database

OK

X

6. After selecting a backup file location, click [Backup MyAssistant Database]

7. When the process has completed, a message will appear that states the backup was successful,
and will list the folder location where the backup was saved.

8. After finishing, click [OK].

Now that your MyAssistant database has successfully been backed up, continue with the upgrade of your

MyAssistant software.

Upgrade Guide
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Server Upgrade

Chapter 2 — Upgrading the MyAssistant Server
Perform the following to initiate the MyAssistant Server upgrade.

1. (Optional) Log on to your Sage 300 MyAssistant server with a Windows user that has
Administrator or Unlimited permissions. You do not need to do this step if you already logged in
as an administrator to back up your MyAssistant database.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running on the server.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is
accessible from all workstations where MyAssistant will be installed.

Perform the following to initiate the MyAssistant Server Upgrade:

a) Open the location of the downloaded MyAssistant Installation files.

b) Unzip the files to a folder in the same shared folder the .ZIP file was placed.

¢) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open:

Sage 300

Construction and Real Estate

MyAssistant

20.3.5

Version 20.3
» View Installation Guide.

» Install Server.

» Install Workstation.

SageCRE.com | Exit |

Click [Install Server] to start the MyAssistant Server upgrade.
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Server Upgrade

Step 1 — MyAssistant Server Upgrade

The MyAssistant Installation wizard displays once you have selected the type of install.

[&] MyAssistant - Setup Server >
Welcome Welcome to the MyAssistant Server Installer
This wizard will guide you through the MyAssistant installation process. You may be asked
Install Prereqiusites to restart your system after installing prerequisites.

®  Prerequisites
®  Mylssistant

Before continuing installation, please close all applications (such as Microsoft Outlook,
Virus Scanners, and Spyware Detectors), since they can interffere with the My Assistant
installation.

Mext = Cancel

Click [Next] to continue.
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Server Upgrade

Step 2 — MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE
MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation
files.

[M2] MyAssistant - Setup Server *

License Terms for MyAssistant Server

License Terms IMPORTANT - READ CAREFULLY: This Software &
Install Prereqiusites License Agreement (the “Agreement”) is a legal agreement
between you - either an individual or a single entity - the
("Licensee™) and Innovative Software Design, Inc.
("ISD™).  This Apreement applies to the computer
software product, in machine readable form, that
accompanies this Agreement (the “Software”),
documentation and related services. YOU AGREE TO
BE BOUND BY THE TERMS OF THIS AGREEMNT
BY DOING ONE OR MORE OF THE
FOLLLOWING, OR ALLOWING OR
AUTHORIZING A THIRD PARTY TO DO IT FOR
YOU: A) CLICKING “T ACCEPT THE TERMS IN
THE LICENSE AGREEMENT™, B) INSTALLING THE
SOFTWARE OR C) USING THE SOFTWARE. IF
YOU DO NOT AGREE TO BE LEGALY BOUND BY
THIS AGREEMENT, IN IT°S ENTIRETY, YOU DO
NOT HAVE A LICENSE TO USE THE SOFTWARE
AND SHOULD NOT INSTALL, COPY, OR USE THE v

[J I accept the terms in the license agreement

Mezt = Cancel

If you agree to the terms of the License Agreement, check the | accept the terms in the license agreement
checkbox and click [Next] to continue.
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Server Upgrade

Step 3 — Prerequisites for MyAssistant Server

This window displays the prerequisite software, if any, that MyAssistant will need upgrade. Click [Next] to
update your prerequisite software.

CAUTION: Itis only recommended that you check the box next to “Do not upgrade SQL Server
Express” if you or your IT support has already installed your own version of SQL Server 2012 or later to
use with MyAssistant (including any full versions of SQL Server your company has purchased).
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Server Upgrade

Step 4 — MyAssistant Software

In this step you will determine where the updated MyAssistant Program Files will be installed on your
server.

[Ma] MyAssistant - Setup Server >

MyAssistant Server

The default location where the MyAssistant program files will be installed to is C:
“Program Files (x86)\Innovative Software Design'My Assistant. You may use the
Install Preregiusites Browse button to specify a different location on your local computer.

Install My Assistant

Select a location to install MyAssistant:
C:\Program Files («86)\Innovative Software Design My Assistant

Browse...

‘\ Installing MyAssistant application...

\ I

\ Mext = Cancel

Accept the default location or use the [Browse] button to specify a different location. It is recommended that
you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant Server software.
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Server Upgrade

Step 5 - You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

[&] MyAssistant - Setup Server >

You have completed instaling MyAssistant Server

o Congratulations! You have finished installing the MyAssistant Server. The MyAssistant Server
Install Prereqiusites must be activated and configured to run. To activate the server, run the MyAssistant
Configuration Manager.

Finished

Finish

Click [Finish] to close the wizard and have the option to continue to the Configuration Manager.

E] NOTE: You must step through the Configuration Manager on the server before upgrading
MyAssistant on any Workstations.
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Step 6 — Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

MyAssistant - Setup Server

Your MyAssistant Server needs to be configured before it can
be used.

Do you want to run the MyAssistant Configuration Manager
now?

Yes Mo

Server Upgrade

Click [Yes]. Continue to Chapter 4 to walk through the MyAssistant Server Configuration Manager.

Upgrade Guide
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Additional Settings

Chapter 3 — MyAssistant Server Configuration

This chapter walks through MyAssistant Server Configuration Manager, where you will upgrade your
MyAssistant database and verify that all settings are still accurate. Configuring the server must be completed
before upgrading MyAssistant on any Workstations.

Read this section carefully:

You will complete the following steps to configure the MyAssistant Server:

Upgrade your MyAssistant database.

Confirm the prefilled file paths for Sage data folders

Confirm the prefilled Mail Server settings for sending emails with MyAssistant
Confirm the MyAssistant Server settings

NOTE: Reactivating the software and stepping through the Configuration Manager on the

MyAssistant Server will take approximately 10 minutes.

PwON P
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Additional Settings

Step 1 - Welcome

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path:
Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

@ MyAssistant Server Configuration Wizard — O 4
| p— | Welcome to the MyAssistant Server Software Configuration Wizard e
Product Activation You wil need the following to configure the MyAssistant Server software:
SQL Server Database Connection
MyAssistant Database «'four Sage Customer Number and MyAssistant Server Product Key @
Sage 300 CRE Data Folders # A Sage 300 CRE User name and password that MyAssistant will use to access Sage 300 CRE data
Notification Email Accounts
i & The outgoing mail server information; including the server name, username(s), password(s), and email
Server Options address(es) that MyAssistant will use to send emails
\\\
\ +| Show Advanced Options @
\
"I
Mext = Cancel

Only check Show Advanced Options if you are using a Web Proxy Server, or would like to define new
Microsoft SQL Server credentials to access MyAssistant data. It is highly recommended you do not change
SQL Server credentials, as those used by the MyAssistant Server prior to upgrade are remembered.
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Additional Settings

Step 2 — Product Activation

In most cases, MyAssistant will remember the Customer Number and Server Product Key previously used to
activate the MyAssistant Server.

@ MyAssistant Server Configuration Wizard - O x
Product Activation 2

Welcome

| Product Activation | ) _
Enter your Sage Customer Number and MyAssistant Server Product Key to activate the
SQL Server Database Connection MyAssistant Server software.
) Customer Number: [ ]
Myassistant Database
Server Product Key:

Sage 300 CRE Data Folders

+ | se Web Proxy Server
Motification Email Accounts
Web Proxy Address:

Server Options
User MName:
Password:

Domain:

Activate

< Back Next = Cancel

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the
information entered is accurate.

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options
in the Welcome Screen (Step 1).
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Step 3 — Database Connection

Additional Settings

E NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome

step.
@ MyAssistant Server Configuration Wizard — O s
Welcome The following is used to connect to the SQL Server instance that contains 2
MyAssistant database
Product Activation
5L Server Database Connection | saLs N o[
erver Mame: v
Myassistant Databs
yAssisiant Database 50L Server Instance: @IS0
Sage 300 CRE Data Folders Part Number: @ |[4s812
Motification Email Accounts
Server Options
< Back Next = Cancel

CAUTION: Making changes in this step can break the connection to the MyAssistant database.
Modifying these fields requires advanced knowledge of SQL Server database engines. It is highly
recommended that you do not make any changes in this step when upgrading your MyAssistant Server.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port
Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.
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Additional Settings

Step 4 — Upgrade the MyAssistant Database

MyAssistant will perform the necessary steps to upgrade your database.

@ MyAssistant Server Configuration Wizard - [} X
Welcome MyAssistant Database
Product Activation MyAssistant needs to upgrade your database to the newest version, This may take
) 3 few minutes. Please click Next to proceed with the upgrade.

MyAssistant Database Connection

Sage 300 CRE Data Folders

NotiFication E-Mail Account

Server Options Updating database: 80% completed...

\

< Back _ Next > [ | Cancel

Click [Next] to upgrade the database.
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Additional Settings

Step 5 — Sage 300 CRE Data Folders

Verify that the information in this step is still accurate. These are the data folders MyAssistant will be able to
monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

@ MyAssistant Server Configuration Wizard - O X
. Define Sage 300 CRE Data Folders 2]
Welcome
Product Activation Enter a Sage 300 CRE operator and password that MyAssistant will use to access Sage 300 CRE data.

SQL Server Database Connection
Sage 300 CRE User: () |SageUser

MyAssistant Database Sage 300 CRE password: | FFssessss
Sage 300 CRE Data Folders | Show characters
Motification Email Accounts ~+ Add Folder §= SOL Reports
Server Options Sage 300 CRE Folder Location Mame
» C:\ProgramData\Sage{TIMBERLINE OFFICE\Data\C... | Timberline Construction
L]
< >

Importing custom fields: 28% completed. ..

Click [Next] to continue. If there is more than one data folder entered, you will be prompted to select
which folder’s Database Customizations to import. If there is only one data folder specified, Database
Customizations will be imported automatically.

If the Sage 300 CRE password entered above is set to expire, a warning message will appear. When the
password does expire, you will need to reopen the MyAssistant Configuration Manager and enter the new

password in this step. Updating the settings for this User account in Sage so the password never expires
is recommended.
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Step 6 — Notification E-Mail Account

Verify your mail server settings are still accurate, or update them if they have changed.

Additional Settings

Welcome

Product Activation

SQL Server Database Connection
MyAssistant Database

Sage 300 CRE Data Folders

Motification Email Accounts

@ MyAssistant Server Configuration Manager

Notification Email Accounts

Specify the email account(s) MyAssistant will send emails from on this server.
Qutgoing Email Server:
Outgoing Email Server Port: @ Use an 55L / TLS connection

From Email Account(s): @

Show password characters

) Default From MName Email Address User Name Password
Server Options
4 Test...
. |
< Back Mext = Cancel
Click [Next] to continue.
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Additional Settings

Step 7 — Server Options

This final step is used to determine a variety of settings around the MyAssistant Server.

@ MyAssistant Server Configuration Wizard _ = <
Welcome Server Options
Product Activation

Daily Summaries

SQL Server Database Connection Daily Summary can be used to send someone a list of notifications across multiple subjects (Tasks)

MyAssistant Database Deliver summary emails at: | 4:00 am -

Sage 300 CRE Data Folders Send Errors To: @

Motification Email Accounts

Recipient name:

Eoa Recipient email:

Browse...

Running Tasks and Sending Service Settings:

Determine the number of concurrent processes that will be used to run MyAssistant Tasks and send emails.

Concurrent processes to run Tasks: 13 Task timeout in minutes: 290
Concurrent processes to send email: 2 5 Sending Timeout in minutes: | 240 -
< Back Finish Cancel

Daily Summaries: MyAssistant Daily Summary email messages are used to send each recipient their
notifications across several Tasks in one email message. See the MyAssistant User Guide for more
information. This time should be after all of your daily Tasks have run.

Send Errors To: Someone to be notified when MyAssistant encounters an error. It is recommended to
send error messages to the primary MyAssistant user.

Running Tasks and Sending Service Settings:

MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background
processes (i.e. Windows Services) on the server. These processes are now scalable to increase
performance, and auto-correct in the event of a hang.
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Additional Settings

These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other
processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables
affect the system resources used when Tasks run and emails are sent, including:
e The available server memory
e Disk drive performance
e Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at
night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

e Complete the MyAssistant server configuration with the default settings and the MyAssistant
workstation installation.

e Activate two MyAssistant Tasks you will regularly use.

e Use the Windows Task Manager and the Resource Monitor to track server memory usage and
disk queue lengths when both Tasks are run concurrently.

e Open the MyAssistant Configuration Manager and increase or decrease the number or processes

based on available server resources.
Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant installation is complete.
Continue to Chapter 5 to install the MyAssistant Workstation.
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Workstation Upgrade

Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (e.g. drive letter “T:”) to access your Sage 300 CRE data or Program Files, you
need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows
Service that runs MyAssistant Tasks to access your Sage 300 CRE database or programs.

How do | know if | am using the Drive Mapper?
Perform the following:

1.
2.
3.

Log on to the server where the MyAssistant server is installed
Open Windows Explorer
Go to the folder where the MyAssistant Program Files are installed. If you accepted the default
location when installing the software, the MyAssistant Program Files will be in the following
location:

C:\Program Files (x86)\Innovative Software Design\MyAssistant
Look for a file named InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll in the
MyAssistant, Task Service, or Sender Service folders.

If this file exists, you are using the MyAssistant Drive Mapper and it will need to be updated in all three
locations (the MyAssistant, Task Service and Sender Service program folders).

1d

CAUTION: The MyAssistant Drive Mapper must be used if you are using mapped drives to access

your Sage 300 data files or Program Files. If you are using UNC paths and do not use any mapped drives,
you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssistant Drive Mapper:

1.

Log on to the computer where the MyAssistant Server is installed using the account that activated the
MyAssistant Server. Often this is an Administrator account.

Open the folder containing the MyAssistant installation files. This will be a location you selected when
saving the files. There is no default location.

Using Windows Explorer, copy and replace the file
InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll from the Tools >
DriveMapperCommand folder in the MyAssistant installation files to the folder where the MyAssistant
software has been installed. If you accepted the default location when installing the MyAssistant
software, this location will be C:\Program Files\Innovative Software Design\MyAssistant.

The InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll also needs to be placed
in the following locations:

a. Program Files\Innovative Software Design\MyAssistant\Sender Service
b. Program Files\Innovative Software Design\MyAssistant\Task Service

Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService
from the Windows Services window. Follow the instructions below to do this.

Click to open the Start menu and click [Run]

In the Run box type services.msc to open the Windows Services window
Look down the list for ISDAdminTaskService and ISDAdminSenderService
Restart both of these services.

PwnNPE

The MyAssistant Drive Mapper tool is now upgraded.
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Workstation Upgrade

Chapter 4 — Upgrading the MyAssistant Workstation(s)

IMPORTANT: If you are upgrading a Terminal or Citrix Server, please go to Chapter 6.

Perform the following to initiate the MyAssistant Workstation upgrade.

1. Log on to your Sage 300 MyAssistant workstation as the Windows user who has MyAssistant
activated.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running.

3. If accessible from the Workstation, open the same folder of unzipped MyAssistant install files
used to upgrade the MyAssistant Server. If not, perform the following to initiate the MyAssistant
Workstation Upgrade:

a) Download the MyAssistant Installation files and open the folder they were downloaded to.
b) Unzip the files to a folder on the local drive of the Workstation.
c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

Sage 300

Construction and Real Estate

MyAssistant

20 3.5
20.3.5

» View Installation Guide.

» Install Server.

» Install Workstation.

sace

| SageCRE.com | Exit |

Select [Install Workstation] to perform a MyAssistant Workstation upgrade.
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Workstation Upgrade

Step 1 - Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will
appear:

[M] ryassistant - Setup Workstation *

Welcome Welcome to the MyAssistant Instaler

This wizard will guide you through the MyAssistant installation process. You may be asked
Install Preregiusites to restart your system after installing prerequisites.

®  Prerequisites
® Mylssistant

Before continuing installation, please close all applications (such as Microsoft Outlook,
Virus Scanners, and Spyware Detectors), since they can intefere with the My Assistant
installation.

Mext = Cancel

Click [Next] to continue.
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Step 2 — MyAssistant License Agreement

Workstation Upgrade

Read and accept the Innovative Software Design End-User License Agreement. You must accept the

Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

@ MyAssistant - Setup Workstation

License Tems

Install Prereqiusites

License Terms for MyAssistant

*

IMPORTANT - READ CAREFULLY: This Software
License Agreement (the “Agreement”) is a legal agreement
between vou - either an individual or a single entity - the
(“Licensee™) and Innovative Software Desipn, Inc.
("ISD™).  This Agreement applies to the computer
software product, in machine readable form, that
accompanies  this  Agreement (the “Software”),
documentation and related services. YOU AGREE TO
BE BOUND BY THE TERMS OF THIS AGREEMNT
BY DOING ONE OR MORE OF THE
FOLLLOWING, OR ALLOWING OR
AUTHORIZING A THIRD PARTY TO DO IT FOR
YOU: A) CLICKING “T ACCEPT THE TERMS IN
THE LICENSE AGREEMENT”, B) INSTALLING THE
SOFTWARE OR C) USING THE SOFTWARE. IF
YOU DO NOT AGREE TO BE LEGALY BOUND BY
THIS AGREEMENT, IN IT'S ENTIRETY, YOU DO
NOT HAVE A LICENSE TO USE THE SOFTWARE
AND SHOULD NOT INSTALL, COPY, OR USE THE

| accept the tems in the license agreement

Mezxt =

Cancel

Click [Next] to continue.
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Workstation Upgrade

Step 3 — Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no
software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all
prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

Step 4 - Install the Software

Select the location where the MyAssistant Program Files will be installed.

@ MyAssistant - Setup Workstation ot

MyAssistant
The default location where the MyAssistant program files will be installed to is C:
“Program Files (x86)\Innovative Software Design'My Assistant. You may use the
Install Preregiusites Browse button to specify a different location on your local computer.

Install MyAssistant

Select a location to install MyAssistant:
C:“Program Files (86} \Innovative Scftware Design My Assistant

Browse...

Mext = Cancel

Accept the default location or use the [Browse] button to specify a different location. It is recommended that
you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant software on the workstation.
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Workstation Upgrade

Step 5 - You have Completed Installing MyAssistant

Congratulations. MyAssistant has been successfully upgraded on this machine.

[M&] MyAssistant - Setup Workstation >

You have completed instaling MyAssistant

o Congratulations! You have finished instaling MyAssistant. When you launch MyAssistant for
Install Prereqiusites the first time you will be asked to provide some basic information to activate and connect to
the MyAssistant Server.

Finished

Finish

Click [Finish] to close the setup wizard.
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Workstation Configuration

Chapter 5 — MyAssistant Workstation Configuration

E] NOTE: In most cases, MyAssistant remember prior settings and open automatically. However, in
some instances you may be required to complete the User Configuration Wizard.

Step 1 — Welcome Screen

Double click on the MyAssistant icon on the desktop to open the MyAssistant Configuration Wizard.

@ MyAssistant User Configuration Wizard = O *
Welcome To MyAssistant 8
| Welcome |
Product Activation You wil need to the folowing information to configure MyAssistant:

S0L Server Database Connection

Sage 300 CRE Data Folders » Your MyAssistant customer number and Activation codes [ ]

Your Settings

| Show Advanced Options )

MNext = Cancel

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Start > All Programs > MyAssistant (File) > MyAssistant
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Workstation Configuration

Step 2 — Product Activation

All settings in this step should be prefilled from the last time MyAssistant was activated on this computer.
Confirm MyAssistant is activated, and that any Web Proxy Settings are up-to-date.

@ MyAssistant User Configuration Wizard - O *
Product Activation 7]
Welcome
| Product Activation |

Enter your customer number and user product key to activate MyAssistant for user Mitch on this
computer. The product key determines the MyAssistant features available to user MyAssistant

SCL Server Database Connection

Customer Number: [i ]
Sage 300 CRE Data Folders

MyAssistant Product Key:
‘Your Settings
+ |Use Web Proxy Server

Web Proxy Address:
User Name:
Password:

Domiain:

Activate

< Back Mext = Cancel

E NOTE: The Web Proxy Server connection fields will only be available if you clicked [Show Advanced
Options] in the Welcome step.

Click [Next] to continue.
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Workstation Configuration

Step 3 — Entering Sage 300 CRE Data Folder Information

Confirm the Sage login credentials and Sage data folder paths are still accurate.

E] MyAssistant User Configuration Wizard — O X
. Define Sage 300 CRE Data Folders (2]
Welcome
Product Activation Enter a Sage 300 User name and password that MyAssistant wil use to access Sage data.

SQL Server Database Connection
Sage 300 CRE User:

Sage 300 CRE Data Folders

Sage 300 CRE password:

Your Settings Show characters
Ignore Sage 300 CRE Folder Location MName
4 O |C: ProgramData\sage {TIMBERLIME OFFICE\D... |Timberline Construction
£ >

< Back MNext = Cancel

Click [Next] to continue.
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Workstation Configuration

Step 4 — User Profile

This step shows the personal information for the Windows user on this workstation, which should prefill.

Eﬂ] MyAssistant User Configuration Wizard — O >
Your Personal Information (2]
Welcome
Product Activation Enter the person’s name and e-mail address for the current Windows User.

Sage 300 CRE Data Folders

il Wy . -
Your Settings Windows User: Administrator

Your Mame:

Your E-mail Address:

+ | Show Notifications in the Sage 300 CRE Desktop
Display MyAssistant Alerts in the System Tray

Show MyAssistant Tile on the Desktop

< Back Finish Cancel

Click [Finish] to close the wizard and open MyAssistant.

Upgrade Guide Page 35



Terminal Server Upgrade
Chapter 6 — Upgrading a Terminal Server

CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at
least one MyAssistant User on a Terminal or Citrix Server.

What is Involved

Perform the following to upgrade MyAssistant on a Terminal or Citrix Server:

Log on to the Server as the Windows user that activated the MyAssistant Server.
Run the MyAssistant Server installation to upgrade.

Confirm the settings in the Server Configuration Manager.

Log on to the machine with the Windows user who uses MyAssistant.

Open the MyAssistant user Application.

If needed, confirm previous settings for user configuration.

oukrwnE

Before Upgrading
Before MyAssistant can be upgraded on any accounts other than the administrator, permissions must be
given to specific files. The default paths have been provided for your convenience below:

e C:\Program Data
e C:\Program Files\Innovative Software Design
OR
e C:\Program Files(x86)\Innovative Software Design

I IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant

users on this machine.

Upgrading the MyAssistant Server

Complete to Chapters 1 through 4 for upgrading the MyAssistant Server. When you have completed
Chapter 4, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix
Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is upgraded and configured, log onto the Terminal or Citrix Server as the
Windows user who will be using the MyAssistant software.

o |Ifthere is a MyAssistant icon on the desktop, double click to open the User Configuration

Manager.
e If there is not an icon on the desktop follow this path:
Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open complete the steps in Chapter 6 to activate the
MyAssistant workstation.
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Conclusion

Chapter 7 — Test the Upgrade

Confirm MyAssistant is working properly by testing the following:

Access Sage 300 CRE Data
1. Open the MyAssistant Designer software from a MyAssistant Workstation.
2. Open an activated MyAssistant Task.
3. Move to the Email step in Task Setup.
4. Expand the very first record in the list of available Sage 300 CRE database records (on the right
side of the window).
Right click on the first field and select [Browse Data].
The data contained in the field should be displayed in the Browse Data window.

oo

Troubleshooting
1. Ifclicking [Browse Data] returns an error:
a. Inthe main MyAssistant window, select File > [Options] to open the Options window.
b. Move to the Sage 300 CRE Data Folder step.
c. Click [Test Connection] to confirm that the Sage 300 CRE credentials entered are able to
access the Sage data. If the test fails, update the credentials.
d. Contact Sage Support if the credentials are correct but you still receive an error when
browsing.
2. If clicking [Browse Data] results in a blank Browse Data window, that field may not have data.
Try another field in the same record.

Run Tasks and Receive Email Messages
1. Open the MyAssistant software from a MyAssistant Workstation.
2. Browse to an activated Task. If possible, select a Task with an attached Crystal Report that is
being sent to you (edit the recipient list as needed).
3. Right click on the Task and click [Run and Send].

Troubleshooting
1. |If the Task doesn't finish running:
a. Log onto the MyAssistant Server.
b. Open the Windows Services window (Start > Run > type: Services.msc).
c. Look for the ISDAdminTask and ISDAdminSender services. Confirm both are started.

2. If the Task finishes running but an email is not received:
a. Click the Reports tab, then [Notifications Not Sent]. If you see Notifications, click the
Refresh button once every thirty seconds until you see “No notifications to send.”
b. If you still don’t receive an email:
a. Open the Windows Services window (Start > Run > type: Services.msc).
b. Look for the ISDAdminSenderService. Right click on the service and select
[Properties].
c. Click the [Log On] tab.
d. Select [This account] and enter a Windows user that is associated with a person
who is an administrator in the Sage 300 CRE software.
e. Click [OK] and then restart the Service.

Conclusion
This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way
around the updated software. Please refer to the User Guide for information on using MyAssistant.
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